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This manual provides you with the basic information
required to get you started with the Simrad DFS75. For a
more detailed description of the operation, see the Simrad
DFS75 Operator manual. If you wish to investigate the
complete functionality, including menus and all parameters,
refer to the Simrad DFS75 Reference manual or the online
help.
Please note that this manual does not provide any
information related to the operation of the Simrad FX80
Catch monitoring system. For such information, please refer
to the relevant FX80 end user documentation.
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About this manual

Purpose
The purpose of this quick start guide is to provide an introduction to safe and efficient
use of the Simrad DFS75.
A good understanding of system functions and controls is essential to fully take
advantage of the functionality provided. Sea conditions vary, sometimes drastically,
and it is not possible to identify settings that will provide the best data at all times.
Careful study of the information in this manual is highly recommended, preferably
while exploring the system’s functionality.
If you need more detailed information about this product, refer to the Simrad DFS75
Operator manual or the Simrad DFS75 Reference manual.
Please note that this manual does not provide any information related to the operation of
the Simrad FX80 Catch monitoring system. For such information, please refer to the
relevant FX80 end user documentation.
Target audience
The manual is intended for all inexperienced and new users of the Simrad DFS75.
Online information
All operation and installation end user documentation provided for your Simrad DFS75
can be downloaded from http://www.simrad.com/fx80.
Registered trademarks
Windows®, Windows XP®, and Windows® 7 are either registered trademarks, or
trademarks of Microsoft Corporation in the United States and/or other countries.
Simrad®, SIMRAD® and the Simrad® logo are either registered trademarks, or
trademarks of Kongsberg Maritime AS in Norway and other countries.
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Study this chapter to familiarize yourself with the Simrad DFS75.
Note

This chapter assumes that the Simrad DFS75 Trawl sonar is provided as an integrated
part of the Simrad FX80 Catch monitoring system.

Important
As with all other advanced instruments, there are a few important things that you must be
aware of.

When the DFS75 is not used
When you are not fishing, and the DFS75 units are on board, switch off the entire system.
Related topics
• Powering down the DFS75 on page 15

If something breaks down
If you believe that something has broken down, contact your local dealer. He will be
able to assist.
A list of all our dealers is provided on http://www.simrad.com. If you are unable to
contact a dealer, observe the support information in this chapter.
Related topics
• Support information on page 10

6
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When you switch off the DFS75
You must NEVER switch off the DFS75 by means of the on/off switch on the computer.
You must ALWAYS exit the DFS75 program by clicking System →Stop and then System
→Off at the bottom of the menu system.

If you power down the DFS75 by means of the computer switch you may damage the
software application and the interface parameters to external devices.
Important

Observe the procedure!
Related topics
• Powering down the DFS75 on page 15

System description
The Simrad DFS75 is an innovative and advanced trawl sonar that allows you to monitor
the fish activity inside your fishing gear using a high resolution colour sonar and echo
sounder. The DFS75 is provided as a natural extension to the Simrad FX80 catch
monitoring system, which also provides a live video feed.
Together, these two systems offer several key features:
• Revolutionizes your ability to identify, analyse and catch
• Live video feed from inside the trawl
• System is a part of the Simrad FX80 that allows you to monitor the fish activity inside
your fishing gear using a live video stream.
• Video recording, editing, export and playback
• High resolution colour sonar and echo sounder images
• Uses standard 3rd wire cable
• Small and light-weight system offers easy installation
• Easy operation using familiar graphic interfaces
A real-time video feed from the trawl has long been desired by fishermen and researchers
alike. Cabling and slip-rings have been the issue. One of the primary design criteria of
the Simrad DFS75 system was to make it work on existing 3rd wire cables. We have
achieved this goal using copper core coax cables. The use of existing copper core coax
cables eases the cost and reduces the installation time.
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The Simrad DFS75 Trawl sonar is integrated into the Simrad FX80 system to establish an
efficient and accurate monitoring system for your gear and your catch. The combination
of the high resolution images from the trawl sonar and the live video feed provides
you with an unparalleled opportunity to identify and analyse both trawl movements
and fish behaviour.
The entire Simrad DFS75 system – with live video and high resolution sonar – is
controlled from a standard Processor Unit provided by Simrad. It is small, but yet
powerful, and contains no moving parts. The system design will allows you to use two
displays. Many users prefer this configuration, as it allows them to use one display
system for the trawl sonar presentations, and another for the live video feed.

System units
The Simrad DFS75 comprises the following main units.

Colour display
A commercial colour display is used with the Simrad DFS75 system.
Note that the colour display is not a standard part of the DFS75 delivery.

Processor Unit
The Processor Unit is a marine computer based on the
Microsoft Windows® 7 operating system. It is designed
for rugged use.
The Processor Unit runs both the FX80 and the DFS75
programs simultaneously.
The unit is normally mounted in the wheelhouse.
The design allows you to use two displays. This may be an advantage for use with the
DFS75 Trawl sonar. One display is then set up to operate and monitor the live video
feed, while the other is used to operate the trawl sonar.
Note

The Processor Unit (Marine Computer) does not contain any fans. It will be very warm,
even during normal operation.

Bridge Control Unit
The Bridge Control Unit provides all the interface and power supply functionality for
the system. It is connected to the Communication Hub in the Trawl Deployment Unit
with a high quality 3rd wire cable. This cable is used for both data communication (live
video and sonar feed) and power.

8
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The Bridge Control Unit is connected to the computer with an Ethernet cable. Additional
Ethernet connections allow you to connect a second computer, and/or interface the ship’s
network. A serial line is provided to communicate with the ship’s navigation system.
The Bridge Control Unit is designed for installation in a 19" rack. Its total height is 4U,
and the depth is approximately 470 mm including the handles.

3rd wire cable
The third wire cable is not a part of the delivery. It must be provided by the installation
shipyard or the client.

Winch system
The cable winch is not a part of the delivery. It must be provided by the installation
shipyard or the client.

Trawl Deployment Unit
The Trawl Deployment Unit is made from
polyurethane. It has been designed for tough use and
the harshest of environments, yet it is easy to handle.
The Trawl Deployment Unit is the main underwater
container for the system. It comprises two separate
bodies assembled within a steel frame. One body
• The FX80 Trawl Deployment Unit holds the
Communication Hub. The 3rd wire cable is connected to this hub, which provides
the interfaces to the Camera Unit and the Sonar Head.
• The DFS75 Trawl Deployment Unit holds the DFS75 Sonar Head.

Communication Hub
The Communication Hub is located inside the FX80
Trawl Deployment Unit. This hub communicates with
the Bridge Control Unit using the 3rd wire cable. It
provides three interfaces to subsea units:
• Camera and LED lamp
• DFS75 Sonar Head
• Auxiliary unit
All connections are made using underwater connectors. Connectors that are not in use
must be protected with dedicated lids.

380737/A

9

Simrad DFS75

Sonar Head
The DFS75 Sonar Head is position inside the DFS75
Trawl Deployment Unit. The Sonar Head provides the
high resolution sonar image. Optional transducers and
hydrophones can be connected to the Sonar Head to
offer an echo sounder presentation, and to communicate
with PS, PI or PX catch monitoring sensors on the
trawl.
The Sonar Head is connected to the Communication Hub with a single cable.

Camera Unit
The Camera Unit is the assembly that contains the
underwater monochrome camera and the powerful
LED lamp.
The Camera Unit is normally mounted inside the trawl
opening, or above the cod end. It is connected to the
Communication Hub inside the Trawl Deployment
Unit using a dedicated 4th wire cable.

(CD012303-001)

Tip

On large trawls, the distance between the Trawl Deployment Unit and the Camera Unit
will require a very long 4th wire cable. We recommend the use of a second winch with
drum to hold this cable.
The Camera Unit is only in use by the FX80 system.

Support information
If you need technical support for your Simrad DFS75 you must contact your local
dealer, or one of our support departments. A list of all our dealers is provided on
http://www.simrad.com.
Norway (Main office)
• Company name: Kongsberg Maritime AS / Simrad
• Address: Strandpromenaden 50, 3190 Horten, Norway
• Telephone: +47 33 03 40 00
• Telefax: +47 33 04 29 87
• E-mail address: simrad.support@simrad.com
• Website: http://www.simrad.no
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Spain
• Company name: Simrad Spain
• Address: Poligono Partida Torres 38, 03570 Villajoyosa, Spain
• Telephone: +34 966 810 149
• Telefax: +34 966 852 304
• E-mail address: simrad.spain@simrad.com
• Website: http://www.simrad.es
USA
• Company name: Kongsberg Underwater Technology Inc / Simrad Fisheries
• Address: 19210 33rd Ave W, Lynnwood, WA 98036, USA
• Telephone: +1 425 712 1136
• Telefax: +1 425 712 1193
• E-mail address: simrad.usa@simrad.com
• Website: http://www.simrad.com
Malaysia
• Company name: Kongsberg Maritime Malaysia Sdn. Bhd
• Address: Unit 27-5 Signature Offices, The Boulevard, Mid Valley City, Lingkaran
Syed Putra, 59200 Kuala Lumpur, Malaysia
• Telephone: +65 6411 7488
• Telefax: +60 3 2201 3359
• E-mail address: simrad.asia@simrad.com
• Website: http://www.simrad.com
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Getting started

This chapter describes how to get started with the basic operation of the DFS75.
It contains a brief overview of the basic system operation and procedures. If you are a
first time user, we recommend that you read through this chapter while operating the
DFS75 so that you can familiarize yourself with the menus, dialog boxes and display
presentations.

Power on/off procedures
These procedures explain how to switch the DFS75 system on and off.
Important

In this manual, the phrase “click” means that you shall place the cursor over the specified
button, field or function, and press the left mouse (or trackball) button once. The phrase
“double-click” means that you shall press the mouse button twice rapidly.
The phrase “press” means that you shall press a physical button with your finger, for
example a character button or the Enter key on the keyboard.

Powering up the DFS75
Purpose
This procedure explains how to power up the Simrad DFS75 system.
Once you have deployed the Trawl Deployment Unit with the Sonar Head, the Simrad
DFS75 will establish a high resolution sonar picture from the fishing gear.
Note

This procedure assumes that you are using the DFS75 Trawl sonar as an integrated part
of the Simrad FX80 Catch monitoring system.
Prerequisites
a

12

All cables - including the 3rd wire and the 4th wire - are in good working order.
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b

The fishing gear with the Trawl Deployment Unit and Camera Unit is located on the
trawl deck, and an oral communication line is open between the personnel on the
trawl deck and yourself on the bridge.

Related topics
• Trawl deck procedures for
deployment and retrieval on
page 27

WARNING - HIGH VOLTAGE
This Equipment MUST BE Earthed

LIM
DISABLE

DSL LINK
(LINK STATUS)

ETHERNET
POR T 2

• Mounting the DFS75 Trawl
Deployment Unit on the fishing
gear on page 32

HV STOP
(LIM FAULT)
(CABLE FAULT)

HV START
(HV ON)

POWER
ON/OFF

SIMRAD FX80
Bridge Control Unit
BCU10

(CD012306-01 1)

Procedure
1

Power up the system on the bridge.
a

Power up the Bridge Control Unit using the front mounted switch (A).
Tip

There are two power switches on the Bridge Control Unit, one on the front
panel and one on the rear panel. Both switches must be set to “On”. During
normal operation, you only need to use the front mounted switch (with the
safety cover) to power on (and off) the unit.
b

Power up the colour display.
If required, refer to the instructions provided by the display manufacturer.

c

Power up the Processor Unit (computer).
Wait for the operating system to start up.

d

Double-click the FX80 icon on the desktop to start the program.

e

Wait while the program starts on the computer.

f

Observe that the program presentation fills the entire screen.

g

Observe that the FX80 starts.
The FX80 starts up using the same operational parameters as the last time you
used it. If these parameters are acceptable, continue operation. If you wish to
alter basic operational parameters, see the dedicated procedures.

h

Press the HV START button (B) on the Bridge Control Unit.
Observe that the green light is lit after a short moment. The DSL STATUS lamp
is flashing awaiting communication with the Communication Hub.

i

Observe that the blue indicator lamp on the Communication Hub inside the
Trawl Deployment Unit is lit.
This lamp indicates that the high voltage from the Bridge Control Unit is
present.
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j

Observe that the DSL STATUS lamp is lit continuously (red) to indicate that
the communication between the Communication Hub and the Bridge Control
Unit is operational.
This means that the communication is operational.
On the FX80 Status bar, observe that the Communication Hub is connected.
Since the camera is not yet connected to the Communication Hub, you will not
be able to see any live feed.

2

Lay out the aft part of the fishing net, and mount the Camera Unit in the chosen
position.

3

Ensure that the 4th wire is properly connected to the “Y” cable, and that the two
connectors are firmly attached to the camera and LED lamp.

4

Deploy the trawl.

5

When you reach the headrope, stop the deployment.

6

Mount the Trawl Deployment Unit to its chosen location or kite.

7

Connect the 4th wire cable to the Communication Hub.

8

Observe the information provided on the FX80 Status Bar.
The connection speed will depend on the length and quality of the third wire. Verify
that the Hub and Camera status indicators in the bottom left corner of the FX80
presentations both show Connected.

9

On the bridge, click Live Feed on the Operation menu, click the play button [►],
and observe the video presentation to verify that the FX80 is operational.

10 Use the Camera Lamp functionality to check the lamp.

11 On the FX80 Operation menu, enable the Auxiliary Port 1.
12 Start the DATSS program to access the DFS75 Trawl sonar.
a

Click the DATSS icon on the Processor Unit desktop, wait for the program
to start.
If you have previously used the trawl sonar – and saved the settings – you can
jump to step g).

b

On the right side of the presentation, click the Setup tab.

c

Click Connect Sonar on the Setup menu.
Observe that the Connect Sonar dialog box opens.

14

d

Click Head 1 in the system structure, then click Detect Heads.

e

Click Apply.

f

Observe that the Connect Sonar dialog box closes.

g

In the lower right hand side of the presentation, click System →Run.
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h

Wait while the trawl sonar starts.
Tip

If you use only one display, the trawl sonar presentation will now fill the
screen. Press the Windows button on your keyboard to open the operating
system toolbar. That will allow you to see the FX80 program too. If you
have two displays, use the operating system functionality to move one of the
programs to the other display.
13 Deploy the rest of the trawl, observe the live feed while this is done.

Powering down the DFS75
Purpose
This procedure explains how to power off the Simrad DFS75.
Note

This procedure assumes that you are using the DFS75 Trawl sonar as an integrated part
of the Simrad FX80 Catch monitoring system.
Note

You must never switch off the DFS75 only by means of the on/off switch on the computer.
This may damage the software or the interface parameters for external devices. You
must ALWAYS use this procedure.
Procedure
1 Retrieve the fishing gear.
2 In the FX80 program:
a Click the Exit button in the program.
It is located on the Title Bar in the top right corner of the display presentation.
b Observe that the program closes down.
3 In the DFS75 program:
a In the lower right hand side of the presentation, click System →Stop.
b In the lower right hand side of the presentation, click System →Off.
c Observe that the program closes down.
4 If the computer does not switch itself off automatically, use the functionality
provided by the operating system to switch it off manually.
5 Switch off the colour display.
If required, refer to the instructions provided by the display manufacturer.
6 Press the HV Stop button on the Bridge Control Unit to power down the high voltage
to the Communication Hub in the Trawl Deployment Unit.

380737/A
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7

Press down the Power On/Off button on the Bridge Control Unit to power it down.

Operating principles
Important

In this manual, the phrase “click” means that you shall place the cursor over the specified
button, field or function, and press the left mouse (or trackball) button once. The phrase
“double-click” means that you shall press the mouse button twice rapidly.
The phrase “press” means that you shall press a physical button with your finger, for
example a character button or the Enter key on the keyboard.

Cursor
The mouse (or trackball) controls the cursor movement on the DFS75 presentation. By
moving the cursor over the various information provided on the display, and clicking the
left mouse button, you are able to control all operation.
Tip

If you are left-handed, the Windows operating system allows you to redefine the mouse
buttons. You can then choose to click with the right button.
The shape and purpose of the cursor change depending on its location.

Mouse
The computer mouse can be used to control the functionality provided by the DFS75.
The mouse controls the movements of the cursor, and the buttons are used to click on
buttons and select parameters.

Trackball
All DFS75 functions can be controlled with
the trackball. The ball controls the movements
of the cursor, and the buttons are used to click
on buttons and select parameters. Trackballs
come in several shapes and sizes. A generic
version is shown as an example only.
A

Control wheel (not used)

B

Trackball, use this to control the cursor's
location on the screen

C

Right mouse button (not used)

16
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D

Left mouse button

Starting normal operation
Once you have powered up the complete DFS75 system, you are ready to start the actual
operation.
When started up, the DFS75 will automatically apply its previous setup parameters.

Selecting 'active' view
Purpose
This procedure explains how you can select the ‘active’ view on the DFS75 presentation.
Description
By default, the DFS75 provides its echo information using two presentation views. The
Sounder view is located on the left side of the DFS75 presentation, while the Vertical
view is located on the right hand side.
Tip

You can change the size of each view by clicking on the border line and dragging
it towards left or right.
Certain operational parameters are different in the two presentation views. If you wish to
alter operational parameters related to a view, you must first ‘activate’ the view. You
can do that by clicking inside the view, or using the View button on the top of several
menus. The active view is identified with a blue frame.

By activating a view you will also notice that the options in the Operation and Display
menus are changed to reflect the relevant valid parameters.
Related topics
• Display menu on page 46
• Selecting presentation mode on page 18
Procedure
1 Method 1
Click once inside a view to make it ‘active’.
Observe the blue frame that indicates that the view has been activated.
2 Method 2
a Observe the menu system. It is located on the right hand side of the DFS75
presentation. The vertical “tabs” on the right side allows you to open a specific
menu.
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b

Click the Operation tab to open the Operation menu.

c

Observe the View button.

The number in the view reflects the operational frequency.
d

Click the [–] or [+] buttons on either side of the button to choose the requested
view.

Selecting presentation mode
Purpose
This procedure explains how you can select the presentation mode in the current DFS75
view.
Description
The presentation modes offered by the DFS75
changes the way the echo data are shown. To
choose modes, use the Mode button on the
Operation menu. Which mode to choose from depends on the currently active view.
Tip

You can also change presentation mode using the Scan Mode option on the Scan and
Auxiliary Transmit tabs in the Sonar Head Control dialog box.
Note

The availability of presentation modes depend on the currently active view.
Related topics
• Operation menu on page 44
Procedure
1

Click inside the Sounder or Vertical view to activate it.
The parameter you change will only be applied to the active view.

2

Observe the menu system. It is located on the right hand side of the DFS75
presentation. The vertical “tabs” on the right side allows you to open a specific
menu.

3

Click the Operation tab to open the Operation menu.

4

Observe the Mode button.

5

Click the [-] or [+] on either side of the button to choose the requested option.
You can also click the middle of the button to select from the submenu.

18
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Selecting colour scale and presentation palette
Purpose
This procedure explains how to change the
colour scale and the presentation palette on
the DFS75 sonar picture and echograms.
Description
The total number of colours used in
the presentation will be distributed
between the minimum and maximum
levels identified using the Colour Scale
functionality. Values above maximum
level are shown using the “maximum
level” colour, while values below are
shown with the background colour.
Note

The choice you make here does not have any effect on the DFS75 performance.
Which colour scale to use is mainly a personal preference based on ambient light
conditions, the nature of the echoes and your own experience.
If you choose to use many colours, the resolution of the DFS75 presentation is greatly
improved. It is then easier to distinguish the difference between the various echoes of
different size and/or target strength.
Tip

You can also change the colour scale on the Colours tab in the Display Options dialog box.
Related topics
• Display menu on page 46
• Advanced menu on page 52
Procedure
1

Observe the menu system. It is located on the right hand side of the DFS75
presentation. The vertical “tabs” on the right side allows you to open a specific
menu.

2

Click the Advanced tab to open the Advanced menu.

3

Observe the Colour Scale button.

4

Click the [-] or [+] on either side of the button to choose the requested option.
You can also click the middle of the button to select from the submenu.

380737/A
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5

Click the Display tab to open the Display menu.

6

Observe the Palette button.

7

Click the [-] or [+] on either side of the button to choose the requested option.
You can also click the middle of the button to select from the submenu.

Selecting menu language
Purpose
Description
The menu buttons on the DFS75 can be provided in several different languages.
Use this function to select the language you wish to use. With a few exceptions, the
chosen language will also be used for all other texts on the DFS75.
The chosen language is not supported in the DFS75 dialog boxes.
Related topics
• Operation menu on page 44
Procedure
1

Observe the menu system. It is located on the right hand side of the DFS75
presentation. The vertical “tabs” on the right side allows you to open a specific
menu.

2

Click the Operation tab to open the Operation menu.

3

Observe the Language button.

4

Click the [-] or [+] on either side of the button to choose the requested option.
You can also click the middle of the button to select from the submenu.

Defining the appearance of the menu buttons
Purpose
This procedure explains how you can use the three
dedicated functions to set up the appearance of the
menu buttons to suit you requirements.
Description
Three functions are provided for this purpose.
1

Icons

The iconic symbols on the buttons are provided for easier recognition of the various
functions. However, the graphics take up valuable space. If you wish to remove the
icon to see more of the text, set Icons to Off.

20
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2

Font Size

The Font Size is provided so that you can adjust the size and visibility of the menu
buttons to suit your preferences.
3

Menu Width

The Menu Width is provided so that you can adjust the size and visibility of the
menu buttons to suit your preferences.
This function will alter the size of the text in the buttons. However, the text in
some buttons may be abbreviated due to space limitations. When these buttons are
made wider, the full text will be shown.
Related topics
• Advanced menu on page 52
Procedure
1

Observe the menu system. It is
located on the right hand side of the DFS75 presentation. The vertical “tabs” on the
right side allows you to open a specific menu.

2

Click the Advanced tab to open the Advanced menu.

3

Observe the Icons button.

4

Click the [-] or [+] on either side of the button to switch on or off the icons.

5

Observe the Font Size button.

6

Click the [-] or [+] on either side of the button to choose the requested option.
You can also click the middle of the button to select from the submenu.

7

Observe the Menu Width button.

8

Click the [-] or [+] on either side of the button to increase or decrease the width.

Selecting measurement units
Purpose
This procedure explains how to change the measurement units in the DFS75
presentations.
Description
The measurements units are defined using the Range and Temperature functions on
the Setup menu.
Related topics
• Display menu on page 46
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Procedure
1 Observe the menu system. It is located on the right hand side of the DFS75
presentation. The vertical “tabs” on the right side allows you to open a specific
menu.
2 Click the Setup tab to open the Setup menu.
3 Observe the Range button.

5

Click the [–] or [+] buttons on either side of the button to choose the requested
value. You can also click the middle of the button.
Observe the Temperature button.

6

Click the [–] or [+] buttons on either side of the button to choose the requested value.

4

Controlling the range setting
Purpose
This procedure explains how to define the range on the DFS75.
Description
The Range function allows you to specify the vertical range of the water column covered
by the sonar. The range is defined from the Sonar Head and down to a given range value
in the vertical or horizontal direction. The value shown and selected is by default applied
only to the currently selected view (Sounder or Vertical).
In order to change the range for the Sounder or Vertical view, the view must be activated
before you change the parameter.
Tip

This function can also be controlled on the Transmit and Auxiliary Transmit tabs in the
Sonar Head Control dialog box.

Related topics
• Operation menu on page 44
Procedure
1 Click inside the Sounder or Vertical view to activate it.
The parameter you change will only be applied to the active view.
2 Observe the menu system. It is located on the right hand side of the DFS75
presentation. The vertical “tabs” on the right side allows you to open a specific
menu.
3 Click the Operation tab to open the Operation menu.
4 Observe the Range button.
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5

Click the [–] or [+] buttons on either side of the button to choose the requested value.

Controlling the sonar gain
Purpose
This procedure explains how to change the gain.
Tip

Do not confuse this Gain function with the TVG function.
Description
You can compare this gain setting with the volume control on your car radio. When the
gain is increased, the echoes will appear stronger. Weak echoes will be easier to see.
However, since you also increase the acoustic noise in the reception, the DFS75 echo
presentations will also show this. Too much gain will thus “distort” the presentation.
In order to change the gain for the Sounder or Vertical view, the view must be activated
before you change the parameter.
Tip

• This Gain function can also be controlled using the Panel Gain parameter on the
Transmit and Auxiliary Transmit tabs in the Sonar Head Control dialog box.
• To monitor the gain applied to the received signal, observe the Overload Counter
dialog box opened from the View menu.
• You can also change the display gain on the DFS75. Observe the parameters on the
Controls tab in the Display Options dialog box.
• To change the gain in the catch monitor sensor receiver, observe the Manual Gain
function in the Receiver Setup menu.
Related topics
• Operation menu on page 44
Procedure
1

Click inside the Sounder or Vertical view to activate it.
The parameter you change will only be applied to the active view.

2

Observe the menu system. It is located on the right hand side of the DFS75
presentation. The vertical “tabs” on the right side allows you to open a specific
menu.

3

Click the Operation tab to open the Operation menu.

4

Observe the Gain button.

5

Click the [–] or [+] buttons on either side of the button to choose the requested value.
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Recording echogram and sonar sequences
Purpose
This procedure explains how to store echogram and sonar data. Each sequence of this
data contains a set of acoustic data saved on digital format.
Once saved, you can play back this data just as if it was “normal” DFS75 data.
Description
The recording of echogram and sonar data is controlled from the Recording toolbar
and from the Status Bar.
Note

This procedure assumes that the recording parameters have been previously defined
using the Record dialog box.
Related topics
• Replaying previously recorded echogram and sonar sequences on page 24
• Status Bar on page 39
Procedure
1 Observe the bottom of the display presentation.
If the Status Bar is not visible, observe the following steps.
a Observe the menu system. It is located on the right hand side of the DFS75
presentation. The vertical “tabs” on the right side allows you to open a specific
menu.
b Click the Advanced tab to open the Advanced menu.
c Observe the Additional Menu button.

2

d Click Additional Menu →View →Status Bar to enable it.
Observe the red Record button on the right hand side of the Status Bar.

3

To start recording, click the red Record button.

4

To stop recording, click the red Record button one more time.
The recorded file is placed in the folder you have previously chosen during the
recording setup.

Replaying previously recorded echogram and sonar
sequences
Purpose
This procedure explains how to select and play back a previously recorded data file.
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Description
The playback of raw sonar data is controlled from the System function on the Main
menu, or from the Recording toolbar. This procedure explains how you can use the
System function on the Main menu.
Related topics
• Recording echogram and sonar sequences on page 24
• Status Bar on page 39
• Main menu on page 44
Procedure
1

Observe the menu system. It is located on the right hand side of the DFS75
presentation. The vertical “tabs” on the right side allows you to open a specific
menu.

2

Observe the Main menu at the bottom of the menu system

3

Click the System button to open the submenu, then click Playback.

4

Observe that an operation system dialog box opens to let select the playback file.

5

The playback starts once you click OK in the operation system dialog box.

6

Observe that the Playback Progress dialog box opens to control the playback.
Tip

The Recording toolbar provides additional
functionality to control the playback. This
includes a “fast forward” function. To open the
Recording toolbar, use the Recording Toolbar on/off switch on the Display menu.

Opening the context sensitive on-line help
Purpose
This procedure explains how to access the context sensitive on-line help.
Description
The DFS75 is provided with an extensive context sensitive on-line help system. All
information of the DFS75 Reference manual is also provided in the on-line help. The
on-line help is located in a single proprietary Microsoft CHM file. This CHM file will
also run on any other computer provided that the computer runs a Microsoft operating
system.
To open the help system, click the Help button in any dialog box. This will provide
instantaneous information about the relevant dialog box with links to related procedures
and other topics.
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Navigation in the on-line help file is made by means of the menu system on the left side,
as well as the interactive links in the document.
Note

This procedure explains how you can use the System function on the Main menu.
Related topics
• Opening the context sensitive on-line help on page 25
• Main menu on page 44
Procedure
1 Method 1:
a Observe the menu system. It is located on the right hand side of the DFS75
presentation. The vertical “tabs” on the right side allows you to open a specific
menu.
b Observe the Main menu at the bottom of the menu system
c Click the Help button to open the help system.

2

Method 2:

Click the Help button in any dialog box. The description of the related dialog box
will appear in the help window.

Saving the current user settings
Purpose
This procedure explains how to save the current configuration and parameter settings.
If you have several different sensor configurations dedicated for various gears or
different tasks, we also strongly recommend that you save these.
Description
The user settings functionality is provided on the Settings menu. You can also find
several related functions on the Configuration menu.
Related topics
• Settings menu on page 49
Procedure
1 Observe the menu system. It is located on the right hand side of the DFS75
presentation. The vertical “tabs” on the right side allows you to open a specific
menu.
2 Click the Settings tab to open the Settings menu.
3 Observe the Save Setting button.
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4

Click Save Settings, and fill in a name in the Enter New Setting Name dialog box
that opens.
If you are using a current setting, the name of this setting will appear. If you wish to
overwrite this user profile with new parameters, simply click OK.
If you wish to save the current settings with a new name, type this name, and click
OK.

Trawl deck procedures for deployment and
retrieval
These are the specific procedures required to mount the various DFS75 units onto the
fishing net.

Connecting the 3rd wire cable to the Communication Hub in
the Trawl Deployment Unit
Purpose
Before you can put the DFS75 system to work, you need to connect the 3rd wire to the
Communication Hub. This procedure explains how to splice the 3rd wire to a pigtail cable
provided with the DFS75, and how to connect this pigtail to the Communication Hub.
Note

There are many different 3rd wire cables available, and there are also many ways to splice
the 3rd wire to the pigtail. This procedure explains one method suggested by Simrad.
Important

It is very important that this splicing is done properly. The splice must be completely
waterproof, and there must be no electrical short between the core conductor and the
shield. The quality of this splice is vital for the operational performance of the DFS75.
Description
The 3rd wire cable comprises a core conductor surrounded by a grounding shield,
together these form a coaxial cable. This coaxial cable is enclosed by a protective jacket
and a flexible steel armour.
The 3rd wire cable enters the Trawl Deployment Unit through a dedicated opening,
and it is then supported by a strain relief block in a special compartment. Both the
core conductor and the shield in the 3rd wire is connected to the pigtail provided by
Simrad. The other end of the pigtail cable is provided with a watertight plug, which is
connected to the Communication Hub. The design will not allow you to plug this into
the wrong socket.
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Important

It is very important that the 3rd wire cable enters the Trawl Deployment Unit using an
external proper dimensioned strain relief. This item is not provided by Simrad.
Prerequisites
In order to do this procedure, you will need:
a

The pigtail provided by Simrad as a part of the DFS75 delivery

b

Heat shrinking tubes with diameters to fit the outer diameter of the cables, minimum
total length is 70 cm.

c

Crimping sleeve with relevant set of pliers

d

Tinned braid foil, length approximately 30 cm

e

One tube with mastic

f

Heat gun

g

Isolation tape

h

Multimeter

Procedure
1

Remove the outer steel armour on the 3rd wire cable to access the coax cable. You
need to free at least 20 cm of the coaxial cable.
We have seen that this is done using a grinder, but you must then be very careful.

2

Once you have removed the outer steel armour, the metal edges will be very sharp.
Lift these edges of the armour to access underneath it, and apply several layers of
tape – under the steel armour – for protection. After that, apply several layers of
tape outside the steel armour and its edges to protect personnel and equipment.

3

Remove the insulation on the coax cable (A), and fold back the grounding braid.
Observe the illustration.
You need to free
approximately 80 mm
of the coaxial cable, and
approximately 20 mm of
the core conductor must
be stripped.

4

(CD012308-002)

45 mm

20 mm

Remove the insulation on the pigtail cable (B).
Observe that the pigtail
30 mm
20 mm
100 mm
cable consists of one black
and one white wire. The
white cable is ground.
In total you will need
approximately 150 mm
cable. Cut off and strip the
two cables as shown in the illustration. It does not matter if the ground conductor is
longer than necessary, it will be cut to fit later.
(CD012308-001)
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5

Thread the heat shrinking tubes as follows:
• Onto the pigtail: Approximately 150 mm long
• Onto the 3rd wire cable: First one with length approximately 330 mm, then
another one with length approximately 150 mm

6

Take the stripped end of the black wire in the pigtail cable (B), and insert it into
the crimping sleeve (C).

7

On the 3rd wire cable,
insert the stripped
core conductor into
the other end of the
crimping sleeve (C).
(CD012308-003)

Make sure that the two
cables are laying next to each other inside the crimping sleeve, and that as little as
possible of the stripped wires are shown outside the crimping sleeve.
Tip

If you have problems inserting the two stripped cables, you may need to remove
dust and metal shavings from inside the crimping sleeve. As an alternative, use a
crimping sleeve with a larger diameter.
8

Crimp the sleeve from centre and towards the end alternatively on each side of the
centre. Turn the cable 180 degrees after every second crimping.

9

Clean the remaining cable insulation on each side of the crimping sleeve.

10 Pull over the first heat shrink tube (D) that you previously threaded onto the 3rd wire
cable. Make sure that it covers the crimpoing sleeve, and also reaches as far as
possible over the insulation on each side of the sleeve.
Push the earthing
braids on the coax
cable well back.
Important
(CD012308-004)

Make sure that you
cover the crimping sleeve completely, and that no stripped conductors are visible.
11 Shrink the tube (C) using the heat gun.
Keep the heat moving constantly to prevent overheating, and make sure that you
heat the tube all the way around. Start in the centre of the tube. When it has shrunk,
proceed towards each end, so that the glue is squeezed out. After heating, take a
short break to let the tube cool down.

380737/A

29

Simrad DFS75

12 Pull over the second heat shrink tube (E) that you previously threaded onto the
pigtail cable.
Make sure that
this shrinking tube
covers both the pigtail
wires, as well as
approximately half of
the first shrink tube
(D).
13 Shrink the tube (E) using the heat gun.
Keep the heat moving constantly to prevent overheating, and make sure that you
heat the tube all the way around. Start in the centre of the tube. When it has shrunk,
proceed towards each end, so that the glue is squeezed out. After heating, take a
short break to let the tube cool down.
14 Apply a thin layer of mastic (F) around the end of the first shrinking tube (D).
Make sure that it covers a large part of the shrinking tube as well a a good part
of the coax insulation.
Wind the ground
conductor from the
pigtail cable around
the mastic.
15 Push the cable screen
from the coax cable
(A) over the mastic (F) and the ground conductor from the “pigtail” cable.
Squeeze all well
together to ensure
good contact between
the ground on the coax
cable to the ground on
the pigtail cable.
Cut off excess ground wires, and make sure that no loose strands are left behind.
16 Wind tinned braid (G) tight and tightly all over the joint.
Make sure that each
turn overlaps the
previous turn. Press
the end of the braid
into the layer beyond,
and remove surplus.
Important

Make sure that the tinned braid is winded tight enough over the cable joint. This is
important to ensure proper ground connection.
17 Clean the cables and the shrinking tubes properly.
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18 Pull over the third heat shrink tube that you previously threaded onto the 3rd wire
cable.
Centre the heat sinking tube over the joint, and make sure that it covers the entire
length of the previous heat sinking tubes and the tinned braid.
19 Shrink the final tube using the heat gun.
Keep the heat moving constantly to prevent overheating, and make sure that you
heat the tube all the way around. Start in the centre of the tube. When it has shrunk,
proceed towards each end, so that the glue is squeezed out. After heating, take a
short break to let the tube cool down.
20 Use a multimeter to measure the resistance is the between the two pins on the
pigtail plug.
The resistance should be infinite or very large. If the multimeter indicates a short
circuit you must cut both cables and start from scratch.
21 Mount the strain relief to the 3rd wire cable.
Place the strain relief so that the seam between the 3rd wire cable and pigtail cable
comes right inside the extension, ie inside the Trawl Deployment Unit. If necessary,
adjust the thickness of the 3rd wire cable by wrapping tape tightly around it.
Important

It is very important that the 3rd wire cable is connected to the Trawl Deployment
Unit using an external and proper dimensioned strain relief. This is not provided by
Simrad.
22 Place the pigtail cable inside the Trawl Deployment Unit, and connect it to the
Communication Hub.

Connecting the power and telemetry cable from the Sonar
Head to the Communication Hub in the Trawl Deployment
Unit
Purpose
This procedure explains how to connect the DFS75 Sonar Head to the Communication
Hub.
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A
B
C
D
E

Pigtail connector
Camera connector
Auxiliary 1 connector for DFS75 Sonar
Head
Auxiliary 2 connector (for optional second
sensor system)
Indicator lamp for high voltage

Description
The DFS75 Sonar Head is connected to the
Auxiliary 1 socket on the Communication Hub
using a watertight connector. The cable (green)
and the connector is provided with the Sonar
Head.
Important

The interface between the DFS75 Sonar Head and the Communication Hub is made
using a proprietary format. No parameter adjustments are required.
A

B
C
D

Interface cable and connector
for the power and telemetry
cable to the Communication Hub
Echo sounder transducer
(optional)
Forward looking hydrophone
(optional)
Connector for catch hydrophone
(optional)

Procedure
1 Open the DFS75 and the FX80
Trawl Deployment Units.
2 On the Sonar Head, locate the
green cable with the connector.
3 Connect the green power and telemetry cable from the Sonar Head to the Auxiliary
1 socket on the Communication Hub.
4 Makes sure that you tighten the connectors properly.

Mounting the DFS75 Trawl Deployment Unit on the fishing
gear
Purpose
This procedure explains the basic principles for mounting the DFS75 Trawl Deployment
Unit on the fishing gear.
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Note

There are many different ways to make this installation, and many vessels have
established their own procedures and “best practices” for these tasks. This procedure
explains the basic principals of one method suggested by Simrad.
A

Power and telemetry cable to the
Communication Hub

B

Sonar Head must point towards aft

C

Use rope or strong rubber straps with
snap hooks

D

Fastening rope to the headrope on
the trawl

E

Safety rope

D

A

E

B

C

Description
Most users mount the Trawl Deployment
Unit when after the cod end of the trawl
has been deployed.
No matter how the Trawl Deployment Unit
is mounted on the gear, the most important
task will always be to keep it from falling off during use. Second, you must always
mount the unit so that the acoustic beams from the Sonar Head hits and reflects from the
targets you wish to see.
(CD012312-002)

Important

Make sure that you position the Trawl Deployment Unit while considering the tensions
on the fishing gear once it has been deployed. Keep in mind that when the footrope hits
the bottom, or the cod end is filled with fish, the location of the footrope may change.
The same tensions may also cause the Trawl Deployment Unit to be tilted or pitched.
In most cases, if you cannot see the expected targets on the sonar screen, there is nothing
wrong with the sonar. Check the pitch and roll values. Is the sonar beam really pointing
the right direction?
Simrad will not take any responsibility for any loss of or damage to equipment, even if
our general installation and/or mounting procedures have been followed.
Prerequisites
In order to do this procedure, you will need an ample supply of mounting materials
(wires and ropes, hooks and shackles)
Related topics
• Connecting the power and telemetry cable from the Sonar Head to the Communication
Hub in the Trawl Deployment Unit on page 31
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Procedure
1

Place the DFS75 Trawl Deployment Unit on its chosen location on the fishing net.
This may for example be immediately behind the headrope, or on a kite.

2

Make sure the Trawl Deployment Unit is facing the correct way, the Sonar Head
shall face aft.

3

Make sure that the Trawl Deployment Unit is positioned so that the sonar beam is
pointing in the right direction.

4

Make sure that the mounting takes into consideration the various tensions applied to
the fishing net once it has been deployed.
Once deployed, these tensions may cause the Trawl Deployment Unit to pitch and
roll. They may also cause the footrope to move forward or backward and then “out
of reach” for the sonar beam.

5

Secure the unit to the relevant structures using minimum four wires or ropes from
the metal frame to the net.

6

Connect the power and telemetry cable to the Communication Hub.

Mounting the FX80 Trawl Deployment Unit on the fishing
gear
Purpose
This procedure explains the basic principles for mounting the FX80 Trawl Deployment
Unit on the fishing gear.
Note

There are many different ways to make this installation, and many vessels have
established their own procedures and “best practices” for these tasks. This procedure
explains the basic principals of one method suggested by Simrad.
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A
B
C
D
E

Power and telemetry cable to the
DFS75 Sonar Head
4th wire cable, allow for plenty slack
Non stretchable rope attached to the
4th wire cable
Rope secured to the headrope to take
up the tension
3rd wire cable

E

D

A

Description
Most users mount the Trawl Deployment
Unit when after the cod end of the trawl
has been deployed. No matter how the
Trawl Deployment Unit is mounted on the
gear, the most important task will always
be to keep it from falling off during use.

B
C

(CD012313-001)

Important

1

Make sure that the 3rd wire cable enters the Trawl Deployment Unit using an
external proper dimensioned strain relief. This item is not provided by Simrad.

2

Make sure that the 4th wire cable is connected with proper slack, and with a
dedicated safety rope to accept the tension.

3

Make sure that you position the Trawl Deployment Unit while considering the
tensions on the fishing gear once it has been deployed. Keep in mind that when
the footrope hits the bottom, or the cod end is filled with fish, the location of the
footrope may change. The same tensions may also cause the Trawl Deployment
Unit to be tilted or pitched.

Simrad will not take any responsibility for any loss of or damage to equipment, even if
our general installation and/or mounting procedures have been followed.
Prerequisites
In order to do this procedure, you will need an ample supply of mounting materials
(wires and ropes, hooks and shackles)
Related topics
• Connecting the 3rd wire cable to the Communication Hub in the Trawl Deployment
Unit on page 27
• Connecting the power and telemetry cable from the Sonar Head to the Communication
Hub in the Trawl Deployment Unit on page 31
Procedure
1 Place the FX80 Trawl Deployment Unit on its chosen location on the fishing net.
This may for example be immediately behind the headrope, or on a kite.
2 Make sure the Trawl Deployment Unit is facing the correct way.
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3

Make sure that the mounting takes into consideration the various tensions applied to
the fishing net once it has been deployed.
Once deployed, these tensions may cause the Trawl Deployment Unit to pitch and
roll. They may also cause the footrope to move forward or backward.

4

Secure the unit to the relevant structures using minimum four wires or ropes from
the metal frame to the net.

5

Unless you keep it connected all the time, connect the 3rd wire cable to the
Communication Hub prior to or during the deployment of the trawl.

6

Connect the 4th wire cable to the Communication Hub prior to or during the
deployment of the trawl.

Presentation overview
The display presentation offered by the Simrad DFS75 system provides a Sector view
with a sonar presentation, and a Sounder view with an echogram. It also provide a Status
Bar and a menu system to facilitate operation using a computer mouse or a trackball.

Display organisation
By default, the DFS75 display presentation covers the entire screen view.

A typical DFS75 display presentation is shown. Two views are provided, an Sounder
view on the left hand side (A), and a Vertical view on the right hand side (B). In this
example, the Vertical view is set to presentation mode Net opening.
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This example has been made in Playback mode with previously recorded data. For this
reason, certain presentation elements are not shown. The menu options also reflect the
chosen operational mode.
A

Sounder view

You can change the size of each view by clicking the border line between them
and move it sideways.
B

Vertical view

In order to do changes in a view, you need to ‘activate’ it. To do that, click once in
the view, or click the View button at the top of several menus.
C

Menu

A large menu system is offered to maintain full control of the DFS75 operation.
Choose which menu to use by clicking the tabs at the right hand side. Note that the
parameters provided by certain menus depend on the current view and presentation
mode.
D

Trawl Deployment Unit

This is a real-time presentation of the DFS75 Trawl Deployment Unit movements
and behaviour.
E

Trawl Deployment Unit sensors

The DFS75 Trawl Deployment Unit holds sensors to record its depth and
movements, as well as the ambient temperature.
F

Catch monitoring sensors

If Simrad catch monitoring sensors are used with the DFS75 system, the information
from these sensors are provided here.
G

Operational mode and help

The System button provided allows you to choose operational mode. The Help
button opens the on-line help.
H

Recording toolbar

A dedicated toolbar is provided to allow fast access to key functions related to
recording and playback. To enable the toolbar, click Rec.Toolbar on the Display
menu.

I

Status bar and Message Log

When enabled, a dedicated toolbar is provided to allow fast access to key functions
related to navigation markers. To enable the toolbar, click Status bar on the View
menu.
The Message Log will – when opened – place itself at the bottom of the DFS75
presentation. To open (and close) the Message Log, click Message Log on the View
menu.
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Presentation views
By default, the DFS75 provides its echo information using two presentation views. The
Sounder view is located on the left side of the DFS75 presentation, while the Vertical
view is located on the right hand side.
Tip

You can change the size of each view by clicking on the border line and dragging
it towards left or right.
Certain operational parameters are different in the two presentation views. If you wish to
alter operational parameters related to a view, you must first ‘activate’ the view. You
can do that by clicking inside the view, or using the View button on the top of several
menus. The active view is identified with a blue frame.

By activating a view you will also notice that the options in the Operation and Display
menus are changed to reflect the relevant valid parameters.

Presentation modes
The presentation modes offered by the DFS75
changes the way the echo data are shown. To
choose modes, use the Mode button on the
Operation menu. Which mode to choose from depends on the currently active view.

Operational modes
The DFS75 supports four operational modes. To
choose one of these modes use the System function.
The System function is always available at the bottom right corner of the display
presentation – unless of course you have chosen to hide the menu system.
When you click the button, a small submenu appears to provide four choices.
The following operational modes are available:
1 Stop
The DFS75 is stopped. Neither transmission nor reception takes place, and there is
no communication between the Processor Unit and the Sonar Head.
Note

You have not switched off the entire system. The Bridge Control Unit is still
operating, and the high voltage is still applied through the 3rd wire cable to the
subsea units.
2

Run

The DFS75 is operating normally. Use this mode for normal operation of the system.
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3

Playback

This mode allows you to play back previously recorded sonar sessions. An operating
system dialog box opens to let you choose which file to play back. Once selected,
the Playback Progress dialog box opens to let you control the playback.
Tip

To change playback file, you must first click System →Stop, and then start the
playback one more time.
You can also change to Playback mode by clicking the Play button on the Recording
toolbar.
4

Off

This option closes down the DFS75 program.

Status Bar
The Status Bar is located at the bottom of the DFS75 presentation.
The Status Bar is only shown when you have enabled it. To do so, click the Status Bar
option on the View menu.
The purpose of the Status Bar is to offer information about the current operational mode,
as well as an overview of the interfaces with external devices. The Status Bar also
provides you with fast access to key functions such as screen capture and recording.

The Status bar provides the following functionality (from left):
a

Ready

This status message is provided when the DFS75 is ready for operation.
b

NMEA status

The DFS75 is normally connected to a number of external devices to import
information related to navigation and the vessel’s movements. Each interface is
provided with a colour coded status field on the Status bar.
The following colours are used:
• Green: The data received from the external device have good quality.
• Yellow: The data received from the external device have compromised quality.
• Purple: Identical data received from multiple sensors do not provide the same
information.
• Red: The DFS75 does not receive any data from the external device.
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c

System status

This field provides the current operational mode.
One of the following messages are provided:
• Not recording: The Sonar Head is operational, data recording has not been started.
• Recording: The Sonar Head is operational, data recording is activated.
• Recording paused: The Sonar Head is operational, data recording is temporarily
halted.
• Playback: The Sonar Head has been deactivated, the DFS75 currently shows
information from a previously recorded file.
• Playback paused: The Sonar Head has been deactivated, the DFS75 shows
information from a previously recorded file, but the playback is temporarily
halted.
• Inactive: The Sonar Head has been deactivated, the DFS75 operation has been
temporarily stopped.
d

Screen capture

Click this button once to capture the current presentation. You will not be asked to
enter a file name. The file is automatically named with the current time, and saved
to \diagnostic folder under the DFS75 installation folder.
Tip

If you only need to save one single image, and you wish to control the file name,
you can use the Save Image With Overlays function on the Recording toolbar.
e

Record

Click this button once to start and stop recording. If you have previously defined the
recording parameters using the Record dialog box, you will simply start recording.
If those parameters are not defined, the Record dialog box will open.
Tip

The very first recording you make after defining the recording parameters will be
saved with the file name you specified. The next recordings are made with file
names automatically generated by the current time. They will however be saved in
the folder you specified.
Observe the relevant operational procedures.
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The menu system
The menu system is by default located on the right
hand side of the DFS75 presentation.
The selection of operational parameters on the DFS75
is done using a set of menus, and several menu
buttons and commands. Some of the menu buttons
and commands open dialog boxes to provide additional
parameters.
The menus are located at the top right side of the
display presentation. By means of the tabs, you can
choose which menu to open. The following menus
are available:
• Operation
• Display
• Setup
• Settings
• Sensors
• Receiver Setup
• Advanced
The Additional Menu button at the bottom of the Advanced menu holds three secondary
menus:
• View
• Configuration
• Tools
Tip

The View menu can also be opened by right-clicking anywhere in the display presentation.
The options provided by each menu depend on the chosen presentation mode and the
currently active view. Note that operational parameters defined for the ‘active’ view
does not apply to the other view.
Related topics
• The menu system on page 43

The menu buttons
Each menu contains several menu buttons. Each button shows the function of the button,
some of them also display the current parameter setting. The majority of the buttons in
each menu provide one or more of these functions.
a You can increase and decrease parameter values by clicking the [+] and [–] fields
on the button.
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b

You can select parameter value from the button's submenu.

c

You can click the button repeatedly to change the parameter.

d

You can open a dedicated dialog box.

How to select a numerical parameter using the +/- buttons
1

Move the cursor to either side of
the button, and observe that the
background colour changes.
a

Click on the left side of the button to decrease the numerical value.

b

Click on the right side of the button to increase the numerical value.

How to select a parameter using a submenu
1

Click the middle section of the button
to open a submenu, then click the
requested command, option or button.
The chosen value is applied, and the
submenu is automatically closed.

2

Whenever applicable, you can also
access the submenu by clicking the
left and right side of the button. This method will not show you the choices on
the submenu.
a

Click on the left side of the button to select a 'lower' submenu choice.

b

Click on the right side of the button to select a 'higher' submenu choice.

How to select parameters using a dialog box
1

Click anywhere on the button to open a
separate dialog box.

Context sensitive on-line help
The DFS75 is provided with an extensive context sensitive on-line help system. All
information of the DFS75 Reference manual is also provided in the on-line help. The
on-line help is located in a single proprietary Microsoft CHM file. This CHM file will
also run on any other computer provided that the computer runs a Microsoft operating
system.
To open the help system, click the Help button in any dialog box. This will provide
instantaneous information about the relevant dialog box with links to related procedures
and other topics.
Navigation in the on-line help file is made by means of the menu system on the left side,
as well as the interactive links in the document.
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The menu system

The menu navigation employed by the DFS75 is based on the user interface provided for
the Simrad sonars.
The main menu is by default located at the right side of the screen. To change parameters,
you can either use the dedicated [+] and [–] icons on each side of the individual buttons,
or you can click the centre of the button to open a small submenu. Several buttons
will also open dedicated dialog boxes. [+] and [–] icons shown in dark colours are not
available for the current view or presentation mode.
Tip

This chapter only provides the purpose of each function and dialog box. If you wish to
learn more about the functionality and the parameters offered, refer to the Simrad DFS75
Reference manual or the context sensitive online help.
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Main menu
1

System

The System function allows you to choose
the operational mode, and to close the DFS75
program.
2

Help

Click this button to open the DFS75 context sensitive on-line help. The button
opens the help system’s start page.
Tip

For detailed information about every function, button and dialog box, refer to the DFS75
Reference manual or to the context sensitive on-line help.

Operation menu
The following functions and parameters are available
from the Operation menu.
Note that the choices available on the Operation menu
depend on the currently selected view and presentation
mode. Some functions are not available when the
Sounder view is active, and some are not available
when the Vertical view is active.
1

View

The View button allows you to choose which of
the two views (Sounder or Vertical) on the DFS75
presentation that is ‘active’ and available for
adjustments.
2

Mode

The Mode function (also known as Scan Mode) allows you to choose the presentation
mode to be used in each DFS75 view.
3

Sonar

The Sonar function (also known as Pause Head) allows you to pause the operation
of the DFS75 Sonar Head without changing operational mode or powering down
the system.
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4

Range

The Range function allows you to specify the vertical range of the water column
covered by the sonar. The range is defined from the Sonar Head and down to a given
range value in the vertical or horizontal direction. The value shown and selected is
by default applied only to the currently selected view (Sounder or Vertical).
In order to change the range for the Sounder or Vertical view, the view must be
activated before you change the parameter.
5

Gain

The purpose of the Gain function is to adjust the echo level in the DFS75 sonar
and echogram presentations.
6

Bandwidth

The Bandwidth function allows you to adjust the quality of the sonar presentation by
adjusting the bandwidth of the received echo signal.
7

Frequency

The Frequency function is simply an indicator that allows you to see the operational
frequency of the DFS75.
8

Scan Speed

The Scan Speed function allows you to change the scanning speed for the stepper
motor. In other words, this is how fast the sonar transducer rotates inside the head.
This function is only available for the Vertical view. It is not available if you set the
Vertical view to presentation modes Sounder or Smooth Sounder.
9

Reverse Scan

The purpose of the Reverse Scan function is to reverse the direction of the stepper
motor in the Sonar Head.
This function is only available for the Vertical view. It is not available if you set the
Vertical view to presentation modes Sounder or Smooth Sounder.
10 Audio
The Audio function allows you disable or enable the audio output.
11 Sector Width
The Sector Width allows you to adjust the opening angle of the current sector that
the Sonar Head covers.
This function is only available for the Vertical view. It is not available if you set the
Vertical view to presentation modes Sounder or Smooth Sounder.
12 H(orizontal) Heading
The Horizontal Heading function (also known as Sector Heading) allows you to
specify the centre of the search sector.
This function is only available for the Vertical view. It is not available if you set the
Vertical view to presentation modes Sounder or Smooth Sounder.
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13 Gain Type
The Gain Type function allows you to implement gain filtering using reverberation
control (RCG) and automatic gain control (AGC).
14 Gain Response
The Gain Response function allows you to decide how fast the RCG and AGC filters
in the DFS75 shall react to sudden changes to the echo strength and sonar conditions.
15 Resolution
The Resolution function allows you to change the range resolution of the sonar
presentation.
16 Pulse Type
The Pulse Type function allows you to select between Linear Frequency Modulated
(LFM) and Continuous Wave (CW) pulses.
Tip

For detailed information about every function, button and dialog box, refer to the DFS75
Reference manual or to the context sensitive on-line help.

Display menu
The following functions and parameters are available
from the Display menu.
Note that the choices available on the Display menu
depend on the currently selected active view and the
operational mode.
1

View

The View button allows you to choose which of
the two views (Sounder or Vertical) on the DFS75
presentation that is ‘active’ and available for
adjustments.
2

Mode

The Mode function (also known as Scan Mode) allows you to choose the presentation
mode to be used in each DFS75 view.
3

Palette

The purpose of the Palette function is to choose which colour theme to be used by
the DFS75 presentations.
4

Cursors

The purpose of the Cursors function is to provide bearing and depth information
about selected echoes on the DFS75 presentation.
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5

Tools

Use the Tools function to create annotations on the DFS75 display presentation.
Several tools are available depending on the current mode.
6

Zoom

The Zoom function allows you to magnify details in the DFS75 presentation.
7

Scroll Speed

The Scroll Speed function allows you to control how fast the echogram presentation
shall move from left towards right over the screen.
8

Clear Display

The Clear Display function allows you to refresh the currently selected (‘active’)
DFS75 view.
9

Recording Toolbar

The Recording Toolbar function allows you to show or hide the toolbar with the
playback and recording buttons.
10 Sounder Position
The Sounder Position function allows you to reposition the Sounder view relative to
the Vertical view.
Tip

For detailed information about every function, button and dialog box, refer to the DFS75
Reference manual or to the context sensitive on-line help.

Setup menu
The following functions and parameters are available
from the Setup menu.
1

View

The View button allows you to choose which of
the two views (Sounder or Vertical) on the DFS75
presentation that is ‘active’ and available for
adjustments.
2

TX Power

The TX Power function allows you to increase or decrease the transmission power.
3

Range Unit

The purpose of the Range Unit function is to control the unit of range measurements
used by the DFS75.
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4

Temperature Unit

The purpose of the Temperature Unit function is to control the unit of temperature
measurements used by the DFS75.
5

Language

The purpose of the Language function is to select the language to be used on the
menus and elsewhere in the graphical user interface.
6

Sound Speed

The purpose of the Sound Speed adjustment is to control the sound speed value;
how fast the sound waves travel through the water. The parameter is used by the
software to estimate range, propagation loss and spreading loss, all of which are
essential concepts in the DFS75.
7

Sound Speed Override

The Sound Speed Output function allows you to use a different value for sound
speed during playback than what was originally recorded.
Note

The Sound Speed Override button is only available in Playback mode.
8

I/O Setup

The I/O Setup dialog box allows you to control the properties of each of the available
communication channels on the DFS75 Processor Unit.
9

Sensor Setup

The Sensor Setup dialog allows you to define which of the Simrad catch monitoring
sensors to use with the DFS75.
10 Connect Sonar
The Connect Sonar dialog box is used to establish communication with the Sonar
Head in the Trawl Deployment Unit.
Note

The Connect Sonar button is only available when the system is set to Off.
Tip

For detailed information about every function, button and dialog box, refer to the DFS75
Reference manual or to the context sensitive on-line help.

48

380737/A

The menu system

Settings menu
The following functions and parameters are available
from the Settings menu.
1

Setting

The Settings function allows you to select and put
to use one of the saved user profiles.
2

Save Setting

The Save Setting function allows you to save the current user profile using a unique
name. You can use your own name, or any name describing for example a fishing
situation.
All user selectable parameters are saved.
3

Rename Setting

The Rename Setting function allows you to rename the current user profile using a
unique name.
4

Delete Setting

The Delete Setting function allows you to delete the current user profile from the
hard disk.
5

Factory Default

The Factory Default function allows you to retrieve and put to use the default
operational parameters defined by the manufacturer.
Tip

For detailed information about every function, button and dialog box, refer to the DFS75
Reference manual or to the context sensitive on-line help.
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Sensors menu
The following functions and parameters are available
from the Sensors menu.
1 View
The View button allows you to choose which of
the two views (Sounder or Vertical) on the DFS75
presentation that is ‘active’ and available for
adjustments.
2

Catch sensors

All catch monitoring sensors that are currently
connected to the DFS75 are shown with one button
for each measurement. For each sensor the type
and status are identified. You are not permitted
to change the type of sensor from this menu, but you can disable the reading by
setting the sensor to Off. To manage sensors and measurements, observe the Sensor
Setup button and dialog.
3

Catch Alarm

The Catch Alarm function allows you to enable visual indicator to notify you when
one or more of the catch sensors are triggered.
4

Sensor Presentation

The Sensor Presentation function allows you to change the physical size of the sensor
buttons in the Sensor Panel at the bottom of the DFS75 menu.
5

Sensor Panel

The Sensor Panel function allows you to place the sensor information on a selected
location on the screen. By default, the Sensor Panel is located at the bottom of
the menu system.
6

Sensor Setup

The Sensor Setup dialog box allows you to define which catch monitoring sensors
that shall be used with the DFS75 system.
7

Channel Spectrum

The Channel Spectrum dialog box allows you to monitor the information provided
to the DFS75 from the catch sensors.
Note

The Channel Spectrum button is only available when the DFS75 is in operational
mode Run.
Tip

For detailed information about every function, button and dialog box, refer to the DFS75
Reference manual or to the context sensitive on-line help.
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Receiver Setup menu
The following functions and parameters are available
from the Receiver Setup menu. Note that this menu is
only available in operational mode Run.
1

View

The View button allows you to choose which of
the two views (Sounder or Vertical) on the DFS75
presentation that is ‘active’ and available for
adjustments.
2

Interference Filter

The Interference Filter function allows you to
remove interference (noise and false echoes) from
other echo sounders and sonars in the vicinity of your own vessel.
3

Interference Filter Level

The Interference Filter Level function allows you to specify the strength of the
interference filter.
4

Sensor Filter

The Sensor Filter can be used if you have problems with the reception. It will
average the data received from the sensors.
5

Catch/Bottom Sensor Filter

The Catch/Bottom Filter is used to restrict the change of state from the catch and
bottom contact sensors. This will reduce jitter in the presentation.
6

AGC

The AGC function allows you to apply an automatic scaling of the received data.
7

Manual Gain

The Manual Gain function allows you to apply a selected amount of gain to the
receiver circuitry.
8

Multipath Filter

The Multipath Filter is designed to remedy for reflections, spikes and time-lag in
the sensor data. These problems may occur if neighbouring channels are used, or
if the DFS75 is disturbed by other hydroacoustic systems in use on your own or
other vessels.
9

Water Profile

The Water Profile functions allows you to set up the sensor communication for
use in salt or fresh water.
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10 Detection Threshold
The Detection Threshold is used to control the threshold level for detection of
signals. Signals below the threshold level will not be detected, while signals above
the threshold will be detected. If threshold level too low this may cause false
signals to be detected.
11 Maximum Shooting Speed
The Maximum Shooting Speed function allows you to compensate for the Doppler
effect during deployment of the trawl.
Tip

For detailed information about every function, button and dialog box, refer to the DFS75
Reference manual or to the context sensitive on-line help.

Advanced menu
The following functions and parameters are available
from the Advanced menu. Note that several options
on this menu are only visible in operational mode Run.
1

View

The View button allows you to choose which of
the two views (Sounder or Vertical) on the DFS75
presentation that is ‘active’ and available for
adjustments.
2

TVG

The TVG (Time Variable Gain) function allows
you to compensate the received data for loss due
to geometric spread.
3

Peak Detection

The Peak Detection function allows you to increase
the sonar image resolution by increasing the
sampling frequency in the Sonar Head while maintaining the same number of
samples on the data sent to the Bridge Control Unit.
4

Orientation

The Orientation function allows you to specify in which way the Sonar Head is
pointing; fore or aft.
5

Audio Setup

The Audio Setup dialog box allows you to define the various parameters related to
the audio output.
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6

Filter

The Filter function permits you to enhance the quality of the reception and
presentation by reducing the acoustic interference.
7

Grid

The Grid functions allows you to enable or disable the depth lines in the currently
active view.
8

Menu Autohide

When enabled, the Menu Autohide function will automatically hide the menu system
when the cursor is located in the DFS75 echo presentation views. Once the cursor is
moved back to the right side of the display, the menu system reappears.
9

Colour Scale

The purpose of the Colour Scale function is to control the number of colours and
colour theme used by the DFS75 in the echogram and sonar presentations.
10 Threshold
The Colour Threshold function allows you to reduce or increase the number of
colours. This will provide a filtering effect that removes the weakest echoes.
11 Span Monitors
The Span Monitors function allows you to distribute the DFS75 presentation to
more than one colour display.
Note

This menu option will only be available if:
a

The Processor Unit is equipped with a display adapter that supports more
than one colour display.

b

The operating system has been set up to use more than one colour display.

12 Icons
The Icons function allows you to enable or disable the use of iconic symbols in
the menu buttons.
13 Font Size
The Font Size functions allows you to increase or decrease the size of the text in the
menu buttons. If you select a different size, the width and height of the buttons
will automatically change accordingly.
14 Menu Width
The Menu Width function allows you to change the physical size of the menu
buttons. Only the width is changed, not the height, and not the font size.
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15 Sonar Head Info
The Sonar Head Info dialog box – and the Sonar Head Info tab in the Sonar Head
Control dialog box – allows you to monitor key parameters and software versions
related to the Sonar Head. It also allows you to run the head calibration, and you
can read the operational voltages inside the Sonar Head.
16 Additional Menu
This Additional Menu button opens a small submenu with access to three special
purpose menus.
→ View menu on page 54
→ Configuration menu on page 56
→ Tools menu on page 58
Tip

For detailed information about every function, button and dialog box, refer to the DFS75
Reference manual or to the context sensitive on-line help.

View menu
Tip

The View menu is opened by clicking Advanced
→Additional Menu →View.
You can also open the menu by right-clicking anywhere
in the active view.

The following functions and parameters are available
from the View menu.
1 Clear Display
The Clear Display function allows you to refresh
the currently selected (‘active’) DFS75 view.
2

Pitch/Roll Alarm

The Pitch/Roll Alarm function allows you to enable
or disable this alarm related to the Sonar Head
movements.
3

Depth Graph

The Depth Graph function opens a dedicated
dialog box to present the depth of the Sonar Head
as a function of time.
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4

Temperature Graph

The Temperature Graph function opens a dedicated dialog box to present the
ambient water temperature around the Sonar Head as a function of time.
5

Overload Counter

The Overload Counter function allows you to monitor the gain “overload”.
6

Head Settings

The Head Settings dialog box is in fact a predefined gauge window. It allows you to
view the current operational parameters of the DFS75 Sonar Head.
7

FS Sensors

The FS Sensors dialog box is in fact a predefined gauge window. It allows you to
view the current environmental parameters of the DFS75 Sonar Head.
8

NMEA Data

The NMEA Data dialog box is in fact a predefined gauge window. It allows you to
view the current input data from external devices such as navigation information
from a Global Positioning System (GPS).
9

Audio

This function is also provided on the Operation menu.
The Audio function allows you disable or enable the audio output.
10 Display Options
The purpose of the Display Options dialog box is to control the colour scale, palette
and grid colours used on the DFS75 presentation. It also allows you to modify other
parameters related to the display presentation, such as gain, grid and scroll speed.
11 Gauge Windows
The Gauge Windows dialog box allows you to create your own information windows
to provide an overview of selected operational and/or technical parameters.
12 Sensors Setup
This function is also provided on the Sensors and Setup menus.
The Sensor Setup dialog box allows you to define which catch monitoring sensors
that shall be used with the DFS75 system.
13 Sonar Head Control
The purpose of the Sonar Head Control dialog box is to provide all relevant
operational parameters for the Sonar Head.
14 On-screen keyboard
This is an on/off switch. When enabled, you can use the operating system’s
on-screen keyboard to type in data.
15 Playback Progress
The Playback Progress dialog box allows you to control the playback status and
speed when the DFS75 is set in Playback mode.
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16 Geometry Sensors Graph
The Geometry Sensor Graph function opens a dedicated dialog box to present the
geometry measurements as a function of time.
17 Status Bar
The Status Bar function allows you to show or hide the Status Bar.
18 Message Log
The Message Log function allows you to show or hide the messages provided by
the DFS75 during operation.
19 Clear Message Log
The Clear Message Log function allows you to remove all content from the message
log. It will not delete the log file on the hard disk.
In order to clear the messages, the Message Log must be enabled and shown at the
bottom of the presentation.
Tip

For detailed information about every function, button and dialog box, refer to the DFS75
Reference manual or to the context sensitive on-line help.

Configuration menu
Tip

The Configuration menu is opened by clicking
Advanced →Additional Menu →Configuration.

The following functions and parameters are available
from the Configuration menu. Note that several options
on this menu are only available in operational mode
Run, other are one available when the DFS75 is
switched to Stop.
1

Connect Sonar

The Connect Sonar dialog box is used to establish communication with the Sonar
Head in the Trawl Deployment Unit.
2

Program Factory Baud Rate

The Program Factory Baud Rate dialog box allows you to reprogram the
communication speed within the Sonar Head.
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3

Update Sonar Firmware

The Update Sonar Firmware dialog box allows you to update the software that
resides inside the Sonar Head.
4

Revert Sonar Firmware

The Revert Sonar Firmware dialog box allows you to revert to the previous version
of the software that resides inside the Sonar Head.
5

Sound Speed

The purpose of the Sound Speed adjustment is to control the sound speed value;
how fast the sound waves travel through the water. The parameter is used by the
software to estimate range, propagation loss and spreading loss, all of which are
essential concepts in the DFS75.
6

Post Processing

The Post Processing dialog box allows you to enable and control specific filters.
7

Operational Settings

The Operational Settings function allows you to select which user profile (settings)
you wish to use, and to add or delete user profiles from the hard disk.
8

Save Settings

The Save Setting function allows you to save the current user profile using a unique
name. You can use your own name, or any name describing for example a fishing
situation.
All user selectable parameters are saved.
9

Load Settings

The Load Setting function allows you to load previously saved user settings.
10 Choose Settings On Startup
This is an “on/off” switch.
When this function is enabled, a dedicated dialog box – Select User And Operational
Settings – is provided to request user and settings when the DFS75 software program
is started.
Tip

For detailed information about every function, button and dialog box, refer to the DFS75
Reference manual or to the context sensitive on-line help.
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Tools menu
Tip

The Configuration menu is opened by clicking
Advanced →Additional Menu →Tools.

The following functions and parameters are available
from the Tools menu.
1

Arrow

This is the default tool. Click Arrow tool to
“switch off” the tool your are currently using.
2

Reference Cursor 1/2

This is the same function as the Cursor function provided on the Display menu. Two
different cursors can be placed on the presentation.
3

Tape Measure

This is the same function as Tape on the Tools function provided on the Display
menu. A line will be drawn on the presentation to present length and angle.
4

Height Measure

This is the same function as Height on the Tools function provided on the Display
menu. A line will be drawn on the presentation to measure height.
5

String Measure

This is the same function as String on the Tools function provided on the Display
menu. A line will be drawn on the presentation to define and measure an area.
6

Text

This is the same function as Pencil on the Tools function provided on the Display
menu. You can place a line and a text box anywhere you like.
7

Wiper

This is the same function as Wipter on the Tools function provided on the Display
menu. It will remove annotations.
8

Off Center

This function is not used on the DFS75 system.
Tip

For detailed information about every function, button and dialog box, refer to the DFS75
Reference manual or to the context sensitive on-line help.
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